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Preface

This preface contains these topics:

■ Intended Audience

■ Documentation Accessibility

Intended Audience
Oracle Application Server Standard Edition One Quick Tour is intended for anyone 
interested in a general overview of Oracle Application Server Standard Edition One.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Standards will continue to evolve over 
time, and Oracle is actively engaged with other market-leading technology vendors to 
address technical obstacles so that our documentation can be accessible to all of our 
customers. For additional information, visit the Oracle Accessibility Program Web site 
at 

http://www.oracle.com/accessibility/

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.
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Overview of Oracle Application Server

Standard Edition One

Oracle Application Server Standard Edition One is a complete, integrated application 
server. It has the same functionality as Oracle Application Server Standard Edition, but 
it has been tailored for small to medium businesses and departments. The pre-built 
functions allows simplified installation, management and operation while reducing 
development time. You can do the following using Oracle Application Server Standard 
Edition One:

■ Develop and deploy dynamic Web sites and applications using Oracle Application 
Server Containers for J2EE, PHP and other scripting tools

■ Create personalized portals to access content and applications using Oracle Instant 
Portal and Oracle Application Server Portal

■ Accelerate the performance of your Web site using Oracle Application Server Web 
Cache

■ Manage and secure the entire Web infrastructure using Oracle Identity 
Management and Oracle Application Server Single Sign-On

Architecture
Oracle Application Server Standard Edition One consists of the Oracle Application 
Server middle tier and the Oracle Application Server infrastructure. The middle tier 
includes the following:

■ Oracle Application Server Web Cache (OracleAS Web Cache)

■ Oracle HTTP Server

■ Oracle Application Server Containers for J2EE (OC4J)

■  Oracle Application Server Portal (OracleAS Portal)

The infrastructure includes the following:

■ Oracle Identity Management

■ Oracle Application Server Metadata Repository (OracleAS Metadata Repository)

Oracle Identity Management and OracleAS Metadata Repository provide security and 
metadata support for the middle tier applications. Oracle Identity Management 
manages user authentication, authorization, and identity information. Functionally, its 
main components are:

■ Oracle Application Server Single Sign-On
 One 1-1



What’s New in Oracle Application Server Standard Edition One
■ Oracle Delegated Administration Services

■ Oracle Internet Directory

■ Oracle Directory Integration and Provisioning

The following figure shows the basic architecture of Oracle Application Server 
business applications and the Oracle Application Server Infrastructure services. 

The following figure shows the infrastructure services. These services include Oracle 
Identity Management and OracleAS Metadata Repository.

What’s New in Oracle Application Server Standard Edition One
Oracle Application Server Standard Edition One has been designed to meet the needs 
of small to medium businesses and departments looking for an application server that 
is easy to install, manage and deploy. It includes pre-built functions that reduce 

See Also: Oracle Application Server Concepts
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installation and development time, as well as simplifying Web management. The 
following are some of the new features of Oracle Application Server Standard Edition 
One:

■ Easier to install

One-click installation of Oracle Application Server Standard Edition One makes it 
simple for administrators. The configuration steps have been automated. In 
addition, the scripts necessary for startup and shutdown are created automatically 
during installation. For information about installation, refer to Oracle Application 
Server Installing and Getting Started with Standard Edition One.

■ Easier to manage

Oracle Application Server Standard Edition One processes can be started and 
stopped from the Start menu. In addition, management is controlled through 
Oracle Enterprise Manager 10g Application Server Control Console. An 
administrator can start and stop components, enable and disable components, and 
back up and recover Oracle Application Server using the console.

■ Easier to build and deploy Web sites

Oracle Application Server Standard Edition One has an infrastructure to build and 
deploy Web sites quickly. PHP: Hypertext Preprocessor (PHP) is now 
automatically installed and configured with Oracle Application Server Standard 
Edition One. Oracle Instant Portal uses the core Oracle Application Server Portal 
technology to provide Web content pages without having to build a portal from 
scratch. The WYSIWYG (what-you-see-is-what-you-get) interface makes adding 
and changing content simple. In addition, Oracle Application Server has a 
complete infrastructure for J2EE and Web services. 

The following chapters describe Oracle Application Server components for application 
management, deployment, and Oracle Instant Portal. Demonstrations are included 
with the quick tour to show how procedures are done.
Overview of Oracle Application Server Standard Edition One 1-3
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Managing Oracle Application Server

Oracle Application Server Standard Edition One management tasks, such as starting 
and stopping the middle tier instance, can be done directly from the Start menu. Other 
tasks, such as enabling and disabling components or backing up an instance, can be 
done using Oracle Enterprise Manager 10g Application Server Control Console 
(Application Server Control Console), a Web-based management tool.

This chapter includes the following topics:

■ Using the Start Menu to Start or Stop Oracle Application Server

■ Using Application Server Control Console to Start and Stop Components

■ Using Application Server Control Console to Enable and Disable Components

■ Using Application Server Control Console for Backup and Recovery

Using the Start Menu to Start or Stop Oracle Application Server
The Start menu has shortcuts to start and stop Oracle Application Server, the 
infrastructure and middle tier, and to access the Welcome page, the Management page 
and documentation. This section describes how to use the Start menu to do the 
following tasks:

■ Using the Start Menu to Start or Stop Oracle Application Server

■ Using the Start Menu to Start or Stop the Infrastructure or Middle Tier

Using the Start Menu to Start or Stop Oracle Application Server
The following procedure describes how to start or stop Oracle Application Server, 
including the infrastructure and middle tier, using the Start menu:

1. Select Programs from the Start menu on the taskbar.

2. Select the Oracle Application Server instance name.

3. Select one of the following options:

■ To start Oracle Application Server, select Start all. 

■ To stop Oracle Application Server, select Stop all.

■ To start the management console tool, select Start Application Server Control 
Console.

■ To stop the management console tool, select Stop Application Server Control 
Console.
erver 2-1



Using Application Server Control Console to Start and Stop Components
A window will display the status of the process. You can view process details by 
clicking the Details and Instance Information buttons.

Using the Start Menu to Start or Stop the Infrastructure or Middle Tier
The following procedure describes how to start or stop the Oracle Application Server 
infrastructure or middle tier using the Start menu:

1. Select Programs from the Start menu on the taskbar.

2. Select the Oracle Application Server instance name.

3. Select Advanced Administration.

4. Select one of the following options:

■ To start or stop the infrastructure, select Infrastructure.

– To start the infrastructure instance, select Start Infrastructure Instance. 

– To stop the infrastructure instance, select Stop Infrastructure Instance.

■ To start or stop the middle tier, select Middle Tier.

– To start the middle tier, select Start Middle Tier. 

– To stop the middle tier, select Stop Middle Tier.

A window will display the status of the process. You can view process details by 
clicking the Details and Instance Information buttons.

Using Application Server Control Console to Start and Stop Components
Application Server Control Console is the Web-based management tool for Oracle 
Application Server. The following figure shows a typical Application Server Control 
Console page:

Show Me: A demonstration of using the start menu to start or stop 
Oracle Application Server is available at 

examples/startmenu/startmenu.html

See Also: For more information about starting and stopping Oracle 
Application Server instances, refer to Oracle Application Server 
Administrator’s Guide
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Using Application Server Control Console to Start and Stop Components
You can use Application Server Control Console to start and stop individual and 
groups of components. The following procedure describes how to start and stop 
components using the console:

1. Select Programs from the Start menu on the taskbar.

2. Select the Oracle Application Server instance name.

3. Select Go To.

4. Select Application Server Control Console. The Application Server Control 
Console farm page will be displayed in your browser.

5. Select an instance.

6. Select the system component. The status of the component is shown in the Status 
column.

■ To start a component, select the component and click Start.

■ To restart all components, click Restart All.

■ To stop a component, select the component and click Stop. Click Yes when 
prompted by the system.

■ To stop all components, click Stop All. Click Yes when prompted by the 
system.

Note: When a component is stopped, the overall status of the Oracle 
Application Server instance is considered stopped. 

Show Me: A demonstration of starting and stopping Oracle 
Application Server or its components is available at 

examples/console/console.html
Managing Oracle Application Server 2-3
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Using Application Server Control Console to Enable and Disable 
Components

You can enable and disable components using Application Server Control Console. If a 
component is not used and you want to conserve resources, then disable the 
component. The disabled component will not appear on the console, and will not be 
included in management operations. 

The following procedure describes how to enable and disable components using 
Application Server Control Console:

1. Select Programs from the Start menu on the taskbar.

2. Select the Oracle Application Server instance name.

3. Select Go To.

4. Select Application Server Control Console. The Application Server Control 
Console farm page will be displayed in your browser.

5. Go to the Application Server Control Console farm page.

6. Select an instance.

7. Click Enable/Disable Components.

■ To enable a component, select the component in the Disabled Components list 
and click Remove. 

■ To disable a component, select the component in the Enabled Components list 
and click Move.

More than one component can be selected at a time. To select more than one 
component, press the Ctrl key while selecting the components. 

8. Click OK.

9. Click Yes when prompted by the system. You will only be prompted to confirm 
the procedure when disabling components. 

Using Application Server Control Console for Backup and Recovery 
Backup of Oracle Application Server Standard Edition One is necessary for 
safeguarding against data loss. A comprehensive backup strategy, such as the 
following, is key to safeguarding against data loss:

■ Perform a complete backup of the Oracle Application Server Standard Edition One 
environment. A complete environment backup includes: 

– A full backup of all files in the middle-tier Oracle homes (including Oracle 
software files and configuration files).

– A full backup of all files in the infrastructure Oracle home (including Oracle 
software files and configuration files).

– A complete cold backup of the Oracle Application Server Metadata 
Repository.

– A full backup of the Oracle system files on the host in the environment.

Show Me: A demonstration of enabling and disabling Oracle 
Application Server or its components is available at 

examples/console/console.html
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Using Application Server Control Console for Backup and Recovery
■ Perform configuration and metadata backups on a regular basis.

■ Perform a new, complete backup of Oracle Application Server Standard Edition 
One environment after a major change.

The console can be used to back up and recover configuration files and the metadata 
repository. To perform a full backup of the entire environment, including all Oracle 
software files, use the Oracle Application Server Backup and Recovery Tool (OracleAS 
Backup and Recovery Tool). 

This section includes the following topics:

■ Configuring Backup and Recovery Settings Using Application Server Control 
Console

■ Performing a Backup Using Application Server Control Console

■ Performing a Recovery Using Application Server Control Console

Configuring Backup and Recovery Settings Using Application Server Control Console
Backup and recovery settings must be configured before performing a backup or 
recovery. Each instance must be configured in order to successfully back up and 
recover Oracle Application Server. The following procedure describes how to 
configure the settings using Application Server Control Console. In this procedure, it is 
assumed that it is a single-server installation. The infrastructure instance will be 
configured, and then the middle tier will be configured for backup and recovery.

1. Select Programs from the Start menu on the taskbar.

2. Select the Oracle Application Server instance name.

3. Select Go To.

4. Select Application Server Control Console. The Application Server Control 
Console farm page will be displayed in your browser.

5. Select the infrastructure instance.

6. Click Backup and Recovery.

7. Click Configure Backup/Recovery Settings.

8. Enter the directory path for the infrastructure log files in the Log File Location 
field. Information in the log files can be used to troubleshoot problems. If the 
directory does not exist, then one will be created for the files.

9. Enter the directory path for the infrastructure configuration files in the 
Configuration Files Backup Location field. The location should be independent 
from the disk storage for Oracle Application Server Standard Edition One. If the 
directory does not exist, then one will be created for the files.

10. Enter the directory for the repository database in the Metadata Repository 
Database Backup Location field. The default location is ORACLE_
HOME/product/10.1.2/OracleAS/infra/oradata/seone. If the directory 
does not exist, then one will be created for the files.

The following figure shows the configuration page.

See Also: For information about performing backups and 
recoveries, and OracleAS Backup and Recovery Tool, refer to Oracle 
Application Server Administrator’s Guide
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Using Application Server Control Console for Backup and Recovery
11. Enter the database system identifier (SID) in the Metadata Repository SID field. 
The default is seone.

12. Click OK.

13. Go to the Application Server Control Console farm page.

14. Select the middle tier instance.

15. Click Backup and Recovery.

16. Click Configure Backup/Recovery Settings.

17. Enter the directory path for the middle tier log files in the Log File Location field. 
Information in the log files can be used to troubleshoot problems. If the directory 
does not exist, then one will be created for the files.

18. Enter the directory path for the middle tier configuration files in the Configuration 
Files Backup Location. The location should be independent from the disk storage 
for Oracle Application Server Standard Edition One. If the directory does not exist, 
then one will be created for the files.

19. Click OK.

Performing a Backup Using Application Server Control Console
The following procedure describes how to back up configuration files using 
Application Server Control Console:

1. Select Programs from the Start menu on the taskbar.

2. Select the Oracle Application Server instance name.

3. Select Go To.

4. Select Application Server Control Console. The Application Server Control 
Console farm page will be displayed in your browser.

5. Select an instance.

6. Click Backup and Recovery.

7. Click Perform Backup.

Show Me: A demonstration of how to configure the backup and 
recovery settings is available at

examples/configure/configure.html
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Using Application Server Control Console for Backup and Recovery
8. Select the type of backup for the instance. 

9. Click OK.

A confirmation of the backup will be displayed at the completion of the backup. If 
the backup is not successful, then review the logs to see why the backup failed, 
correct the problem, and rerun the backup.

Performing a Recovery Using Application Server Control Console
Each backup is identified by the time and date the backup was performed. If an 
incremental backup is selected, then Oracle Enterprise Manager 10g will restore the 
most recent full backup before restoring the incremental backup.

The following procedure describes how to perform a recovery using Application 
Server Control Console.

1. Select Programs from the Start menu on the taskbar.

2. Select the Oracle Application Server instance name.

3. Select Go To.

4. Select Application Server Control Console. The Application Server Control 
Console farm page will be displayed in your browser.

5. Select an instance.

6. Click Backup and Recovery.

7. Click Perform Recovery.

8. Select the backup to use for the recovery of the instance.

9. Click OK.

10. Click Yes to proceed with the recovery, or No to return to the Perform Recovery 
page. The instance is automatically shut down when performing a recovery.

Note: Before using the console to back up the infrastructure, it is 
necessary to enable ARCHIVELOG mode. Refer to Oracle Application 
Server Administrator’s Guide for information about enabling 
ARCHIVELOG mode.

See Also: For detailed information about recovery and the options, 
refer to Oracle Application Server Administrator’s Guide
Managing Oracle Application Server 2-7



Using Application Server Control Console for Backup and Recovery
2-8 Oracle Application Server Standard Edition One Quick Tour



Development and Deploy
3

Development and Deployment

Oracle Application Server Standard Edition One can deploy a variety of Web pages 
and applications. It includes PHP (PHP: Hypertext Preprocessor) and Perl scripting 
facilities to build Web sites as well as J2EE-compliant server and development 
applications. In addition, Oracle JDeveloper can be used to develop applications and 
prepare them for deployment.

Deployment is managed using Oracle Enterprise Manager 10g Application Server 
Control Console (Application Server Control Console). 

This chapter includes the following topics:

■ Developing and Deploying PHP Applications

■ Developing and Deploying JSP Applications

■ Deploying Static and Dynamic HTML Pages

Developing and Deploying PHP Applications
PHP is a server-side HTML-embedded scripting language. HTML serves as the basic 
framework for a page. Dynamic PHP code draws content and information from other 
sources, such as an Oracle database. 

The following procedure describes how to create a PHP application that accesses an 
Oracle database. The procedure uses Oracle JDeveloper to create the PHP application. 
It is assumed that the database has the scott/tiger schema enabled and is accessible.

1. Start Oracle JDeveloper 10g. 

2. Select New from the File menu. The New Gallery window will appear.

3. Select Application Workspace.

4. Click OK. The Create Application Workspace window will appear.

5. Enter a name for the application, and a directory. 

Note: In order to use Oracle JDeveloper to create PHP applications, it 
is necessary to download the PHP extension plug-in from the Oracle 
Technology Network at

http://www.oracle.com/technology/products/jdev/htdocs/par
tners/addins/exchange/php/index.html

After downloading the zip file, extract the php_addin.jar file to the 
JDev_home/jdev/lib/ext directory.
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Developing and Deploying PHP Applications
6. Click OK.

7. Right-click the project that corresponds to the new application, and select New. 
The New Gallery window will appear.

8. Expand the Web Tier node by clicking the plus sign (+).

9. Select PHP in the Categories section, and PHP File in the Items section.

10. Click OK. The Create PHP File window will appear.

11. Enter a file name for the PHP file. The file extension should be .php. The directory 
name should not be changed for the application.

12. Configure the database connection for the PHP application using the PHP DB 
Connect option on the Tools menu.

13. Create the PHP application using the PHP Blocks and PHP Statements elements 
available on the Component Palettes. 

14. Save the project as you work on it. The following figure shows Oracle JDeveloper 
and a PHP application.

15. Test the project by selecting the project name from the Run menu.

16. Copy the PHP application directory to the ORACLE_
HOME/Apache/Apache/htdocs directory when it finished. The URL for the 
application will be as follows:

http://hostname:port/directory/file.php

Note: You will need to edit the ORACLE_
HOME/instance/network/admin/tnsnames.ora file to specify 
the database connection information. Refer to the Oracle Database 10g 
documentation for information about editing the file.
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Developing and Deploying JSP Applications
For example, if the directory for the PHP application is ORACLE_
HOME/Apache/Apache/htdocs/php and the file name is dbquery.php, then 
the URL for the for the application will be as follows:

http://hostname:port/php/dbquery.php

Developing and Deploying JSP Applications
JavaServer Pages (JSP) technology is based on Java servlets and, like Java servlets, JSP 
is a server-side technology. A key difference between JSP pages and servlets is that JSP 
pages keep static page presentation and dynamic content generation separate. JSP Web 
page designers use: 

■ HTML tags to design and format the dynamically-generated Web page 

■ JSP standard tags or Java-based scriptlets to call other components that generate 
the dynamic content on the page 

■ JSP tags from custom tag libraries that generate the dynamic content on the page 

After developing a JSP application, the application should have the Web Archive 
(WAR) format for deployment. According to the J2EE specification, every application 
must be assembled and packaged as an Enterprise Archive (EAR) file prior to 
deployment. 

The following procedure describes how to develop and prepare for deployment a JSP 
application using Oracle JDeveloper. 

1. Start Oracle JDeveloper 10g. 

2. Select New from the File menu. The New Gallery window will appear.

3. Select Application Workspace.

4. Click OK. The Create Application Workspace window will appear.

5. Enter a name for the application, and a directory. 

6. Click OK.

7. Right-click the project that corresponds to the new application, and select New. 
The New Gallery window will appear.

8. Expand the Web Tier node by clicking the plus sign (+).

9. Select JavaServer Pages (JSP) in the Categories section, and JSP Page in the Items 
section.

10. Click OK. The Create JSP window will appear.

11. Enter a file name for the JSP. The file extension should be .jsp. The directory 
name should not be changed for the application.

12. Create the JSP using the JSP and HTML elements available on the JSP and HTML 
Component Palettes. 

13. Save the project as you work on it. The following figure shows Oracle JDeveloper 
and a simple JSP application.
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14. Run the project by selecting the project name from the Run menu. A browser 
window will open with the application.

15. Create a deployment profile for the JSP application. The following procedure 
describes how to create a deployment profile using Oracle JDeveloper: 

a. Select the project.

b. Select New from the File menu.

c. Select Deployment Profiles from the General category, and WAR File from 
the Items category.

d. Click OK. The Create Deployment Profile -- WAR File window will appear.

e. Enter a name and location for the profile.

f. Click OK. The profile will be added to the project and the WAR Deployment 
Profile Properties window will appear.

g. Select items in the left pane and enter the corresponding information in the 
right pane.

h. Click OK when done. The location of the WAR and its corresponding EAR file 
will be shown in the Structure pane.

16. Deploy the application. The following procedure describes how to deploy the JSP 
application using the Application Server Control Console. 

a. Select Programs from the Start menu on the taskbar.

b. Select the Oracle Application Server instance name.

c. Select Go To.

d. Select Application Server Control Console. The Application Server Control 
Console farm page will be displayed in your browser.

e. Select the middle tier instance. 

f. Select the appropriate OC4J instance or create a new one. The home instance, 
created during installation, is the default instance for custom applications.
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Deploying Static and Dynamic HTML Pages
g. Click Applications.

h. Click Deploy EAR file. The application deployment wizard will begin and 
guide you through the deployment process. 

The application will be available at the following URL

http://hostname:port/application_name/

In the preceding URL, hostname is the name of the application server, port is the port 
number for the server, and application_name is the name of the application, without the 
EAR extension. For example, if the application is myfavorite.ear, then the URL would 
be as follows:

http://hostname:port/myfavorite/

Deploying Static and Dynamic HTML Pages
Static HTML pages contain consistent content. Dynamic HTML pages contain content 
that is updated or changed automatically, such as a PHP page. The following figure 
shows the code for a simple HTML page.

If the page is not the home page for Oracle Application Server, then the URL would 
include the hostname, port, directory and page name. The directory for the page 

Show Me:

■ A demonstration of creating a JSP application is available at 

examples/jdev/jdev.html

■ A demonstration of creating an application deployment profile is 
available at

examples/deploy/deploy.html

See Also: For more information about deployment, refer to Oracle 
Application Server Containers for J2EE User’s Guide 
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should be located in the ORACLE_HOME/infra/Apache/Apache/htdocs directory. 
The following is the format for the URL:

hostname:port/directory/filename

In the preceding URL, hostname is the name of the application server, and the port is the 
port number for the server.

For example, a new set of pages and a directory have been created for an upcoming 
launch of a new product. The main page for the event is named newgizmo.html. The 
directory is named newWeb, and contains all the pages for the Web event. The newWeb 
directory is located in the ORACLE_HOME/infra/Apache/Apache/htdocs 
directory. The URL for the main page would be the following:

http://hostname:port/newWeb/newgizmo.html

Changing the Home Page
A home page is the first page that users see when they arrive at a Web site. When 
Oracle Application Server Standard Edition One is installed, the Welcome page is the 
default home page. 

The following procedure describes how to deploy a new home page for Oracle 
Application Server Standard Edition One:

1. Create the new home page. The home page must be named index.html.

2. Save the new home page in a directory. It is recommended that you save the new 
home page in a different directory than the htdocs directory. 

3. Select Programs from the Start menu on the taskbar.

4. Select the Oracle Application Server instance name.

5. Select Go To.

6. Select Application Server Control Console. The Application Server Control 
Console farm page will be displayed in your browser.

7. Select the infrastructure instance. You will be prompted to log in.

8. Click HTTP Server.

9. Click Administration.

10. Click Properties.

11. Enter the directory for your home page in the Document Root field. 

12. (Optional) Enter the administrator’s e-mail address in the Administrator’s E-mail 
field.

13. Click Apply to apply the changes.

See Also: For more information about deployment, refer to Oracle 
Application Server Containers for J2EE User’s Guide 

Show Me: A demonstration of setting the home page is available at 

examples/homepage/homepage.html
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Oracle Instant Portal

Oracle Instant Portal makes it easy to create communities of users who can share 
content in a secure environment. Oracle Instant Portal features provide a simple way 
to do the following:

■ Enable content sharing throughout your company

■ Create smaller portals to serve the needs of a particular department

■ Communicate more fully with partners or customers

The Oracle Instant Portal interface and easy editing controls mean you spend less time 
building a portal and more time helping users get their jobs done efficiently. The 
following are some of the key benefits of Oracle Instant Portal:

■ Pre-generated, pre-configured pages mean no initial development costs. Pages are 
ready to receive content immediately.

■ Pre-configured home page displays news, announcements, and newly added 
content. The Favorite content area lets users personalize the content simply.

■ Point-and-click operations for changing style, managing pages, contributing and 
managing content, and managing user access.

■ In-place editing provides simple, WYSIWYG (what-you-see-is-what-you-get) 
editing right on the page. 

With Oracle Instant Portal, you can have a functioning portal in less than an hour. 

This chapter includes the following topics:

■ Understanding Oracle Instant Portal

■ Accessing the First Oracle Instant Portal Instance

Understanding Oracle Instant Portal
The best way to understand Oracle Instant Portal and what it can do for you is to look 
at a sample portal from a fictitious company, Tangfish Intranet. The following figure 
shows the Tangfish portal. 
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The following descriptions relate to the highlighted sections of the preceding figure:

1. The editing toolbar makes it easy for authorized users to interact with the portal. 
All standard editing controls are available when adding text-based items, such as 
cut-and-paste, font controls and full table support. Oracle Instant Portal 
administrators can also access the tools they need to control the look and feel of 
the portal, manage users, and work with multiple portal instances. A single click 
delivers a robust online help system to help answer questions quickly.

2. Each tabbed page can have its own set of supporting pages, available right from 
the navigation area. Add new pages right in context, without ever having to leave 
the parent page. 

3. You can easily add, rename or re-position the tabs, as well as control who has 
access to a page and to what level. Just click a tab while in edit mode. The 
necessary tools are right there.

4. Your corporate name (4a) and logo (4b) can be added to a portal. In addition, a set 
of pre-defined styles make it easy to tailor the portal’s look and feel.

5. Files, images, URLs, and e-mail addresses can be added right on the page, right in 
context. Rich Text items are ideal for short announcements that you want to 
publish directly on the page. Expandable Rich Text items are perfect for longer text 
items when you need to conserve space on the page. Enhance any kind of text item 
with tables, images, and hyperlinks.

6. The Oracle Instant Portal default tabs are based on a typical company model. You 
can use them, or change the names to reflect your organization more closely. A 
travel agency, for example, might prefer tabs named Airlines, Rental Cars, Hotels, 
Restaurants, Discounts, and Package Tours.

Show Me: A demonstration of using Oracle Instant Portal is 
available at

examples/tangfish/tangfish.html
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Accessing the First Oracle Instant Portal Instance
The first Oracle Instant Portal instance is created automatically, as part of the Oracle 
Application Server Standard Edition One installation process. When you first log on to 
Oracle Application Server Standard Edition One, you are presented with the Welcome 
page. The My Company link on the Welcome page takes you to the home page of your 
first portal. 

It is a secure Web site, and you will need to log in to it. Log in as the portal user, 
using the ias_admin password. From there, you can set up and customize the portal in 
a few easy steps. Click the help icon (question mark) at any time for online help.

Use the following URL to go directly to the Oracle Application Server Portal page and 
bypass the Welcome page

http://hostname/pls/portal
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